Experiment AN-3: Neuromuscular Studies

Equipment Required
PC or Mac Computer
IXTA, USB cable, IXTA power supply
NBC-501 Nerve Chamber
iWire-B3G input cable
C-ISO-P5 pin connector-pinjack lead wires (5)
Glass hooks
Pasteur pipettes and bulbs
C-BNC-P2 BNC-dual pinjack stimulator cable
Pinjack-male banana ground cable
Room-Temp & Chilled Amphibian Ringer's solution
Small amounts of reagent solutions

NOTE – plug the iWire-B3G into the IXTA prior to turning it on.

Nerve/Muscle Bath Chamber Setup

Figure AN-3-S1: The NBC-501 nerve bath chamber.

1. Locate the following items: nerve bath chamber and C-BNC-P2 stimulator cable.
2. Also, locate the iWire-B3G recording cable and C-ISO-P5 nerve chamber lead wires.
3. Attach the BNC connector of the C-BNC-P2 stimulator cable to the Stimulator 1 input. Place the sockets, at the other end of the stimulator cable, on the closely-spaced electrodes at one end of the NBC-401 or 402 nerve bath chamber. The red socket goes on the positive stimulating electrode (+S), which is the electrode closest to the end of the chamber. The black socket goes on the negative stimulating electrode (-S), on the opposite side of the chamber to avoid the possibility of the short circuit between the two stimulator cables.

4. Insert the connector on the end of the iWire-B3G biopotential cable into the iWire 1 input of the IXTA. You may need to restart the IXTA.

5. Attach the red, black, white, brown, and green C-ISO-P5 nerve chamber lead wires to the corresponding sockets on the lead pedestal of the iWire-B3G biopotential cable. Place the sockets, at the other end of the lead wires, on the appropriate electrodes of the nerve bath:

   - The green (C) lead is attached to the electrode (G1) between the negative stimulating electrode (-S) and the proximal recording electrode for the nerve (-N).
• The black (-1) lead is attached to the proximal recording electrode for the nerve (-N), the one closest to the ground electrode (G1).

• The red (+1) lead is attached to the distal recording electrode for the nerve (+N), the one between the proximal recording electrode for the nerve (-N) and the ground electrode on the muscle (G2).

• The brown, or clear, (-2) lead is attached to the negative recording electrode for the muscle (-M), which is between the second ground electrode (G2) and the proximal recording electrode for the muscle (-M).

• The white (+2) lead is attached to the positive recording electrode for the muscle (+M), which is next to the negative muscle recording electrode (-M).

• A jumper wire with sockets or insulated alligator clips is attached between the ground electrode on the head of the muscle (G2) and the other side of ground electrode on the nerve (G1). This ground is needed to prevent the artifact from the compound action potential of the nerve from being recorded through the recording electrodes on the muscle.

Figure AN-3-S5: The stimulator cable, and iWire-B3G with five lead wires connected to the IXTA.
**Figure AN-3-S6: The NBC-501 nerve bath chamber with stimulator and recording lead wires attached. Notice that the stimulator leads are attached to the electrodes that are spaced more closely.**

**Stimulator Settings for Experiment AN-3.**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Units/Title</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stimulus Mode</td>
<td></td>
<td>Pulse</td>
</tr>
<tr>
<td>Stimulator Start</td>
<td></td>
<td>With Recording</td>
</tr>
<tr>
<td>Time Resolution</td>
<td>msec</td>
<td>0.01</td>
</tr>
<tr>
<td>Toolbar Step Frequency</td>
<td>Hz</td>
<td>1</td>
</tr>
<tr>
<td>Toolbar Step Amplitude</td>
<td>Volts</td>
<td>0.01</td>
</tr>
<tr>
<td>Toolbar Step Time</td>
<td>Sec</td>
<td>0.0001</td>
</tr>
<tr>
<td>Delay</td>
<td>Sec</td>
<td>0.005</td>
</tr>
<tr>
<td>Amplitude (Amp)</td>
<td>Volt</td>
<td>0.250</td>
</tr>
<tr>
<td>Pulses (#pulses)</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>Pulse Width (W)</td>
<td>msec</td>
<td>0.1</td>
</tr>
<tr>
<td>Time Off (T Off)</td>
<td>msec</td>
<td>0.9</td>
</tr>
<tr>
<td>Time Off Amplitude</td>
<td>Volts</td>
<td>0</td>
</tr>
<tr>
<td>Holding Potential (HP)</td>
<td>Volts</td>
<td>0</td>
</tr>
</tbody>
</table>
The Dissection

1. Place a frog in ice water for 15 minutes. Double pith the frog as soon as it is removed from the ice water.

2. Remove the skin from the legs by making an incision through the skin around the entire lower abdomen. Cut the connections between the skin and the body—especially around the base of the pelvic girdle. Use stout forceps to pull the skin off the frog in one piece (like a pair of pants).

3. Place the frog in a dissection tray with its dorsal side up. Moisten the exposed limbs of the frog with Ringer's solution every five minutes or so.

4. Separate the muscles of the upper leg to expose the sciatic nerve. Muscles are surrounded by connective tissue called fascia, and the large medial and lateral muscles on the dorsal side of the upper leg are joined to each other by a fusion of their fascia along a thin "white line". Grab the muscle groups on either side of the “white line” with a forceps, and firmly pull the muscle groups apart. The fascia will tear.

5. Deflect the muscles away from each other to expose the cream-colored sciatic nerve lying deep between the muscles. The sciatic nerve is covered with fascia, which also includes some blood vessels.

6. Use a glass hook, made by flaming the tip of a Pasteur pipet, to separate the nerve from the fascia and the vessels. If possible, avoid cutting the blood vessels. If bleeding does occur, rinse away the blood with lots of Ringer’s solution. Free the nerve from the knee joint to the pelvis. Use the glass hook to place a thread under the nerve. Keep the exposed nerve moist at all times with Ringer's solution.

7. Carefully separate the muscles of the pelvis to expose the sciatic nerve. Remember to rinse any blood away with Ringer’s solution. The sciatic nerve enters the abdomen of the frog through an opening at the end of the urostyle, a bone that forms part of the pelvis.

8. Carefully expose the remainder of the nerve through an opening along the lateral side of the urostyle. To avoid cutting the nerve, lift the end of the urostyle with forceps as you cut the muscle away from the urostyle with a blunt scissors. Cut along the urostyle from its tip to the vertebral column.

9. Deflect the muscle away from the urostyle to expose the sciatic nerve. Use a glass hook to separate connective tissue from the nerve and to place a piece of thread under the nerve. Move the thread as close to the vertebral column as possible. Ligate the nerve; the leg should jump as the knot is tied tightly.

10. Cut the nerve between the knot and the vertebral column. Keep the exposed nerve moist at all times with Ringer's solution.

11. Use the thread to lift the proximal end of the nerve from the abdomen of the frog. Do not pinch or stretch the nerve. Remove any connective tissues, blood vessels, or nerve branches that may still keep the nerve attached to the body of the frog.

12. Continue to lift and release the sciatic nerve from any tissue that still keeps it attached to the pelvis or thigh. The nerve should be separated from connecting tissues to a point just above the knee joint.
13. Lay the nerve over the muscles of the lower leg and bathe the nerve and muscles with Ringer’s solution. This nerve and the muscles of the lower leg are the preparation that needs to be preserved for this experiment.

14. Expose the femur bone by dissecting away the muscles of the upper leg as close to the knee joint as possible without damaging the sciatic nerve. Use a stout pair of scissors to cut the femur bone as close to the knee joint as possible. Rinse the preparation with Ringer’s solution to moisten the tissue and rinse away any blood.

15. Separate the lower leg and the nerve from the muscles and bone of the upper leg. Cut across the muscles of the thigh and the femur bone as close to the knee joint as possible and without damaging the nerve.

*Warning: Moisten the exposed limbs of the frog with Ringer's solution every five minutes or so.*

16. Either muscle of the lower leg can be used with the sciatic nerve in this experiment. The gastrocnemius muscle can be used in larger nerve/muscle chambers, but the diffusion of drugs through this muscle takes more time. The tibialis anterior muscle fits into smaller chambers and the diffusion of drugs takes less time through this smaller muscle. In either case, the muscles must be separated from each other.

17. Use a glass hook to separate the gastrocnemius muscle from the bone and other muscles of the lower leg.

18. Use scissors to free the Achilles tendon from the connective tissue around the heel of the foot.

**If the gastrocnemius muscle is used:**

1. Firmly tie a thread around the Achilles tendon, leaving the ends of the thread long enough to secure the muscle in the nerve/muscle chamber.

2. Cut the Achilles tendon as close to the bottom of the foot as possible, so the thread is still attached to the gastrocnemius muscle.

3. Move the gastrocnemius muscle away from the rest of the lower leg. Cut the tibiofibula bone and tibialis anterior muscle just below the knee to separate the rest of the lower leg from the preparation. Avoid damaging the gastrocnemius muscle or the sciatic nerve. Rinse the preparation with Ringer’s solution to moisten the tissue and rinse away any blood.

**If the tibialis anterior muscle is used:**

1. Firmly tie a thread around the ankle. Leave the ends of the thread long enough to secure the muscle in the nerve/muscle chamber.

2. Cut the Achilles tendon as close to the bottom of the foot as possible. Move the gastrocnemius muscle away from the rest of the lower leg. Cut across the head of the gastrocnemius muscle as close to the knee joint as possible to separate it from the rest of the lower leg. Avoid damaging the tibialis anterior muscle or the sciatic nerve. Rinse the preparation with Ringer’s solution to moisten the tissue and rinse away any blood.
Placement of Preparation in the Chamber

1. Before moving the nerve/muscle preparation from the dissecting tray to the nerve/muscle chamber, read the following directions.

2. Orient the chamber so that the nerve/muscle preparation can be easily transferred to the nerve/muscle bath chamber. The proximal end of the nerve will be at the end of the chamber where the electrodes are closer together, and the distal end of the muscle will be at the end of the chamber where the electrodes are farther apart.

*Warning: Do not use the thread on the nerve to move the preparation into the bath chamber. Putting too much tension on the nerve could separate the connections between the nerve and the muscle and prevent signals from being conducted from the nerve to the muscle.*

3. Carefully lift the preparation from the dissecting tray and place it in the nerve/muscle chamber using the thread on the end of the muscle and a forceps on the tissue above the knee joint.

*Warning: Do not touch the nerve with the forceps.*

4. To improve contact between the nerve and the electrodes:
   - Place the thread on the proximal end of the nerve under the outermost stimulating (positive) electrode.
   - Gently pull the thread on the proximal end of the nerve to position the section of nerve that is just inside the knot under the outermost stimulating electrode. Secure the thread on the wall of the chamber with soft wax.

5. Carefully move the muscle to a position over its three recording electrodes using the same technique described in Step 3. Do not stretch the nerve past its in situ length. Secure the thread on the end of the muscle to the wall of the chamber with soft wax or dental wax.

6. Fill the nerve/muscle bath chamber with Ringer's solution to immerse the preparation. Cover the bath chamber to prevent evaporation of the Ringer’s solution when the preparation is bathing, or dehydration of the preparation when the Ringer’s solution has been removed.

*Warning: The nerve/muscle preparation used in this experiment is functional for a limited period of time. If the nerve is bathed periodically in Ringer’s solution, it will work for about four hours. To conserve time, complete all the exercises in the experiment before analyzing the data.*
Experiment AN-3: Neuromuscular Studies

Exercise 1: Maximal Muscle Response
Aim: To apply stimulus pulses of increasing amplitude to the proximal end of the nerve, and record the compound action potentials evoked from the nerve and the muscle.
Approximate Time: 30 minutes

Procedure
1. Click the Stimulator Preferences icon on the LabScribe toolbar to open the stimulator control panel if it does not open automatically.

![LabScribe toolbar](image)

*Figure AN-3-L1: The LabScribe toolbar.*

2. Check the values for the stimulus parameters that are listed in the stimulator control panel on the Main window: the pulse amplitude (Amp) should be set to 0.250 V; the number of pulses (#pulses) to 1; and, the pulse width (W) to 0.1ms. The value for a stimulus parameter can be changed by either of two methods: click on the arrow buttons to the right of the window that displays the value of the parameter to increase or decrease the value; or, type the value of the parameter in the window next to the label of the parameter. Click the Apply button to finalize the change in any stimulus parameter.

![Stimulator control panel](image)

*Figure AN-3-L2: The stimulator control panel*
3. Use a Pasteur pipette to lower the level of Ringer’s solution in the nerve bath chamber below the nerve. Make sure that no part of the nerve or the thread holding the nerve in place is in contact with the Ringer’s solution still in the chamber. If necessary, carefully blot any large drops of solution from the recording electrodes and the nerve with the corner of a laboratory wipe.

Note: The stimulus amplitude and width set for this exercise should be strong enough to cause a CAP in a healthy nerve.

4. Click the Record button to stimulate and record from the nerve. The recording stops automatically after one sweep that is 30 milliseconds wide. Type 0.250V in the Mark box. Click the Mark button to attach this notation regarding the stimulus amplitude to the recording. Click the AutoScale All button. The recording should be similar to the one below.

![Figure AN-3-L3: The compound action potential (CAP) from the sciatic nerve is displayed on the upper channel. The CAP from the tibialis anterior muscle is displayed on the middle channel. The time between the cursor at the onset of the stimulus artifact and the cursor at the onset of the muscle action potential is the muscle latency.](image)

5. Change the stimulus amplitude (Amp) to 0.300V by clicking on the arrow buttons next to the value for this parameter as displayed on the stimulator control panel. The value for the stimulus amplitude (Amp) can also be typed into window next the label Amp. Click the Apply button to finalize the change in the stimulus amplitude.

6. Click Record to stimulate the nerve with 0.300V. Type 0.300V in the Mark box and click the Mark button to attach a comment to the recording.
7. Increase the stimulus amplitude (Amp) by an increment of 0.050V using one of the techniques explained in Step 5. Remember to click the Apply button each time to finalize the change in the stimulus amplitude. Record and mark the response of the nerve.

8. Repeat Step 7 until the maximum compound action potential from the muscle is produced.

9. Select Save As in the File menu, type a name for the file. Click on the Save button to save the data file.

10. Fill the nerve/muscle chamber with fresh Ringer's solution to prevent the nerve and muscle from drying out.

11. Increase the stimulus amplitude by another 10% before proceeding to the next exercise. Click the Apply button to finalize the change in the stimulus amplitude. This level of stimulation ensures a supramaximal response from the nerve and muscle.

**Exercise 2: Synaptic Delay**

Aim: To measure the time taken to transmit a signal across the synapse from the end of the nerve to the surface of the muscle fibers.

Approximate Time: 10 minutes

_The time between the nerve action potential and the muscle action potential depends on three major factors: the conduction time down the nerve; the synaptic delay; and, the conduction time of the muscle action potential from the neuromuscular junction (NMJ) to the muscle recording electrodes. Assume that the third factor is negligible. The synaptic delay can be determined by subtracting the conduction time along the nerve from the time interval between the nerve and muscle action potentials._

**Procedure**

1. Make sure the stimulus amplitude (Amp) is set to the supramaximal voltage determined at the end of Exercise 1. If any change was made to the stimulus parameters, click the Apply button to finalize the changes.

2. If necessary, lower the level of Ringer’s solution in the nerve bath chamber below the nerve and blot any drops of solution from the preparation as described in Exercise 1.

3. Click Record to stimulate the nerve with the supramaximal stimulus. Type <Supramaximal> V in the Mark box and press the Mark button to attach a comment to the recording.

4. Select Save in the File menu.

5. Fill the nerve/muscle chamber with fresh Ringer's solution to prevent the nerve and muscle from drying out.

**Exercise 3: Facilitation of the Muscle Response**

Aim: To demonstrate facilitation in a muscle by stimulating the nerve/muscle preparation with a succession of pulses that occur more frequently. Facilitation is an increase in the amplitude of the submaximal muscle action potentials that occur when there is less time between identical stimulus pulses.

---

*Animal Nerve – Neuromuscular Studies – Labs*
Approximate Time: 30 minutes

Procedure

1. Adjust the Display Time and Timed Stop of the sweep to allow more action potentials to be displayed on the computer screen.
   - Open the Edit menu on the Main window and select Preferences.
   - On the Channels window of the Preferences Dialog, change the Display Time and the Timed Stop to 0.300 sec.
   - Click the OK button at the bottom of the Preferences Dialog.

2. Adjust the critical stimulus parameters to the values listed in Table 1 using the same techniques used in Exercise 1. The stimulus amplitude must be set to a voltage that will generate compound action potentials in the muscle with amplitudes that are 50% to 70% of the maximal muscle CAP. Click the Apply button to finalize the changes to these stimulus parameters.

Table AN-3-L1: Stimulus Parameters Required for Measuring the Facilitation of the Muscle.

<table>
<thead>
<tr>
<th>Stimulus Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stimulus Amplitude (Amp)</td>
<td>Volts for 50-70% of Max Muscle CAP</td>
</tr>
<tr>
<td>Number of Pulses (#pulses)</td>
<td>5</td>
</tr>
<tr>
<td>Pulse Width (W)</td>
<td>0.1 msec</td>
</tr>
<tr>
<td>Time Between Pulses (T Off)</td>
<td>20 msec</td>
</tr>
<tr>
<td>Holding Potential (HP)</td>
<td>0</td>
</tr>
</tbody>
</table>

3. If necessary, lower the level of Ringer’s solution in the nerve bath chamber below the nerve and blot any drops of solution from the preparation as described in Exercise 1.

4. Click Record to stimulate the nerve. Type 20 msec Interval in the Mark box. Click the Mark button to attach this notation to the recording.

5. Change the time interval between stimulus pulses (T Off) to 15 msec. Click the Apply button to finalize this change.

6. Click Record to stimulate the nerve. Type 15 msec Interval in the Mark box. Press the Mark button to attach this notation to the recording.

7. Repeat Steps 5 and 6 to record the amplitudes of the muscle compound action potentials in the series as the time interval between the stimuli is decreased. Change the time interval between pulses (T Off) to 10, 5, and 2 msec. Record and mark the recordings at each new time interval.

8. Select Save in the File menu.

9. Fill the nerve chamber with fresh Ringer's solution to prevent the nerve from drying out.
Warning: Do not test the response of the muscle more than two times at each interpulse time interval. The muscle may fatigue with frequent stimulation and may never recover.

Warning: Wear gloves when handling any drug solution, any tissue treated with drugs, or any other object that has come in contact with a drug solution. Some of these drugs are very effective poisons.

Exercise 4: Effects of Eserine
Aim: To measure the changes in the compound action potential of muscle whose neuromuscular junction was exposed to the anticholinesterase, eserine.
Approximate Time: 45 minutes

Procedure
1. Use the same Display Time and Timed Stop that was used in Exercise 3.
2. Adjust the critical stimulus parameters to the values listed in Table 2 using the same techniques used in Exercise 1.
3. Click the Apply button to finalize the changes to these stimulus parameters.

Table AN-3-L2: Stimulus Parameters Required for Measuring the Effects of Eserine and other Drugs on the Nerve/Muscle Preparation.

<table>
<thead>
<tr>
<th>Stimulus Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stimulus Amplitude (Amp)</td>
<td>0.100 V</td>
</tr>
<tr>
<td>Number of Pulses (#pulses)</td>
<td>1</td>
</tr>
<tr>
<td>Pulse Width (W)</td>
<td>0.1 msec</td>
</tr>
<tr>
<td>Time Between Pulses (T Off)</td>
<td>0.9 msec</td>
</tr>
<tr>
<td>Holding Potential (HP)</td>
<td>0</td>
</tr>
</tbody>
</table>

3. If necessary, lower the level of Ringer’s solution in the nerve bath chamber below the nerve and blot any drops of solution from the preparation as described in Exercise 1.

4. Click Record to stimulate the nerve. Type 0.100V in the Mark box. Click the Mark button to attach this notation to the recording.
5. Change the stimulus amplitude (Amp) to 0.200V. Click the Apply button to finalize this change.
6. Click Record to stimulate the nerve. Type 0.200V in the Mark box. Click the Mark button to attach this notation to the recording.
7. Repeat Steps 5 and 6 to record the amplitudes of the compound action potentials on the nerve and muscle up to a maximal response from the muscle. Change the stimulus amplitude by increments of 0.100V. Record and mark the recordings for each new stimulus amplitude.
8. After recording compound action potentials generated by stimulus pulses of different amplitudes, put five drops of the eserine solution (0.01 mg/ml in Ringer's) on the surface of the muscle. Put another five drops of eserine solution on the muscle at one minute intervals for a total of 30 drops.
9. Reset the stimulus amplitude (Amp) to 0.100V. Click the Apply button to finalize this change.
10. Click Record to stimulate the nerve. Type 0.100V-Eserine in the Mark box. Click the Mark button to attach this notation to the recording.
11. Change the stimulus amplitude (Amp) to 0.200V. Click the Apply button to finalize this change.
12. Click Record to stimulate the nerve. Type 0.200V-Eserine in the Mark box. Click the Mark button to attach this notation to the recording.
13. Repeat Steps 11 and 12 to record the amplitudes of the compound action potentials from the nerve and muscle. Use the same stimulus amplitudes as the ones applied to the untreated nerve/muscle preparation. If there is a significant difference between muscle compound action potentials recorded before and after the eserine treatment, proceed to Step 15.
14. If there is no significant difference between muscle compound action potentials recorded before and after the eserine treatment:
   • Repeat the application of eserine in the same manner as it was applied in Step 8.
   • Test the response of the muscle using the procedures used in Steps 9 through 13.
   • If there is a difference between the muscle action potentials recorded before the first eserine treatment and after the second eserine treatment, proceed to Step 15.
   • If there is no difference between the muscle action potentials recorded before the first eserine treatment and after the second eserine treatment, apply a third treatment of eserine. Test the response of the muscle after the third treatment of eserine using the procedures used in Steps 9 through 13. Proceed to Step 15, whether there is a change in the compound action potentials of the muscle or not.
15. Reverse the effects of eserine on the muscle:
   • Remove the Ringer’s solution containing eserine from the bottom of the bath chamber.
   • Rinse the inside of the bath chamber and the surface of the muscle and nerve with fresh Ringer’s solution.
   • Submerge the nerve/muscle preparation in fresh Ringer's solution for five minutes, changing the Ringer’s solution every minute.
16. Lower the level of Ringer's solution in the nerve bath chamber below the nerve and blot any drops of solution from the preparation as described in Exercise 1.
17. Record the compound action potentials from the preparation using the same procedures used in Steps 9 through 13. Mark each recording to indicate the stimulus voltage used while testing the reversibility of the effects of eserine. If the muscle compound action potentials have returned to normal, proceed to the next exercise.

18. If the muscle compound action potentials have not returned to their pretreatment levels:
   - Submerge the nerve/muscle preparation in fresh Ringer’s solution for another five minutes, changing the Ringer’s solution every minute.
   - Retest the response of the muscle using the same procedures used in Steps 9 through 13.
   - If the muscle compound action potentials have returned to normal, proceed to the next exercise.
   - If the muscle compound action potentials have not returned to normal, continue rinsing the preparation with fresh Ringer’s solution until the muscle response recovers. If the muscle has not fully recovered after 30 minutes of rinsing, consult your instructor.

19. Select Save in the File menu.

20. Fill the nerve/muscle chamber with fresh Ringer's solution to prevent the nerve and muscle from drying out.

**Exercise 5: Effects of Other Agents**

Aim: To test the effects of other reagents on the compound action potentials of the nerve and the muscle in the preparation. Each group will be assigned one of the following substances to test: curare, atropine, acetylcholine (high concentration), nicotine, dantrolene, magnesium (high concentration), and calcium (high concentration). Each reagent is dissolved in Ringer’s solution.

Approximate Time: 45 minutes

**Procedure**

1. Begin the study of the reagent that your group is assigned only after the effects of eserine have been reversed, or if the response of the muscle is measurable and stable.

2. Use the same procedures employed in Exercise 4 to test the effects of your assigned reagent on the compound action potentials of the nerve and the muscle.

3. Select Save in the File menu.

4. Follow the directions provided by your instructor for the cleaning of the equipment and the disposal of tissue and reagents.

**Data Analysis**

*Exercise 2-Synaptic Delay*

1. Use the Sweep Selection bar at the bottom of the Main window to display the sweep recorded in Exercise 2. Click on the tab on the selection bar for that sweep and the sweep will appear on the Main window.
2. Transfer the sweep to the Analysis window. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to transfer the sweep from the Main window to the Analysis window.

3. Look at the Function Table that is above the uppermost channel displayed in the Analysis window. The mathematical functions, V2-V1 and T2-T1 should appear in this table. The values for V2-V1 and T2-T1 on each channel are seen in the table across the top margin of each channel.

4. Maximize the height of the trace on both channels by clicking on the arrow to the left of the title of each channel to open the channel menu. Select Scale from the menu and AutoScale from the Scale submenu to increase the height of the data on that channel.

5. Once the cursors are placed in the correct positions for determining the latency of the nerve, the time (T2-T1) can be recorded in the on-line notebook of LabScribe by typing its name and value directly into the Journal, or on a separate data table.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter the name and value of the parameter from the recording to the Journal. To use these functions:
   • Place the cursors at the locations used to measure the latency of the nerve.
   • Transfer the names of the mathematical function used to determine the latency to the Journal using the Add Title to Journal function in the Nerve CAP Channel pull-down menu.
   • Transfer the values for the amplitude to the Journal using the Add Ch. Data to Journal function in the Nerve CAP Channel pull-down menu.

7. Measure the latency of the nerve compound action potential:
   • Place one cursor on the onset of the stimulus artifact displayed on the Nerve CAP channel.
   • Place the other cursor on the onset of the nerve compound action potential displayed on the same channel.
   • The value for T2-T1 function on the Nerve CAP Channel is the latency of the nerve, which is the time it takes the action potential to move from the negative stimulating electrode to the negative nerve recording electrode.
   • Record the nerve latency in the Journal using the one of the techniques described in Steps 5 or 6, and in Table 3.
8. Measure the nerve conduction distance (in mm) between the negative stimulating electrode to the negative nerve recording electrode. Record the nerve conduction distance in the Journal using the one of the techniques described in Steps 5 or 6, and on the data table.

9. Calculate the nerve conduction velocity (in millimeters per millisecond) of the nerve. Divide the nerve conduction distance (in mm) that was measured in Step 9 by the nerve latency (in msec) that was measured in Step 7.

   For example, 10 mm/0.2 msec = 50 mm/msec

   Record the nerve conduction velocity in the Journal, and on the data table.

Note: If the nerve and the nerve/muscle chamber are long enough that the nerve crosses three or more electrodes that can be used for recording nerve action potentials, a more accurate method of determining the nerve conduction velocity can be utilized. This recording can be done monophasically (without a positive nerve recording electrode) or biphasically (with both a positive and a negative recording electrode). If the positive (second) nerve recording electrode is used, it should be placed on electrode (F). Record the compound nerve action potential with the negative (first) nerve recording electrode in position (D). Move this negative nerve recording electrode to a new position (E) and record the compound nerve action potential, again. Measure the distance (in mm) between electrode (D) and electrode (E). Divide this distance (D to E) by the time interval (in msec) between the peak of the action potential recorded at (D) and the peak of the action potential recorded at (E).

10. Measure the muscle conduction distance (in mm) between the negative stimulating electrode and the negative recording electrode on the muscle. Record this distance in the Journal, and on the data table.

11. Calculate the conduction time (in msec) of the nerve compound action potential from the point of stimulation of the nerve, which is the negative stimulating electrode, to the point of recording on the muscle fibers, which is the negative recording electrode on the muscle. Divide the muscle conduction distance (in mm) that was measured in Step 11 by the conduction velocity (in mm/msec) of the nerve that was calculated in Step 10.

   For example, 40 mm/(50 mm/msec) = 0.8 msec

   Record the conduction time of the nerve in the Journal, and on the data table.

12. Measure the latency of the muscle. Place one cursor on the onset of the stimulus artifact displayed on the Nerve CAP channel. Place the other cursor on the onset of the muscle compound action potential displayed on the Muscle CAP channel. The value for T2-T1 function on either the Nerve or Muscle CAP Channel is the latency of the muscle. Record the latency of the muscle in the Journal, and on the data table.

13. Calculate synaptic delay. Subtract the nerve conduction time (stimulus electrode-NMJ) found in Step 12 from the latency of the muscle found in Step 13. Record the synaptic delay in the Journal, and on the data table.

14. Select Save in the File menu.
15. Click on the Main Window icon to return to that window.

**Questions—Synaptic Delay**

1. Is there a more accurate way to make this measurement?

2. What additional factors would be involved if the time between the nerve action potential and muscle contraction were used instead of the time between the nerve and muscle action potentials?

**Table AN-3-L3: Times, Velocities, and Distances Needed to Determine Synaptic Delay**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nerve Latency (msec)</td>
<td></td>
</tr>
<tr>
<td>Nerve Conduction Distance (mm)</td>
<td></td>
</tr>
<tr>
<td>Nerve Conduction Velocity (mm/msec)</td>
<td></td>
</tr>
<tr>
<td>Muscle Conduction Distance (mm)</td>
<td></td>
</tr>
<tr>
<td>Nerve Conduction Time, Stimulus to NMJ (msec)</td>
<td></td>
</tr>
<tr>
<td>Muscle Latency (msec)</td>
<td></td>
</tr>
<tr>
<td>Synaptic Delay (msec)</td>
<td></td>
</tr>
</tbody>
</table>

**Exercise 3—Facilitation of the Muscle Response**

1. Use the Sweep Selection bar at the bottom of the Main window to display the first sweep recorded in Exercise 3. Click on the tab on the selection bar for that sweep and the sweep will appear on the Main window. According to the design of the exercise, the five stimulus pulses delivered to the nerve in this sweep were 20 msec apart.

2. Transfer the sweep to the Analysis window by clicking on the Analysis window icon in the toolbar or selecting Analysis from the Windows menu.

3. Maximize the height of the traces on the Nerve and Muscle CAP Channels by clicking on the arrow to the left of the title of each channel to open the channel menu. Select Scale from the menu and AutoScale from the Scale submenu.

4. Measure the amplitude of the first muscle compound action potential in the series of five. Place one cursor on the baseline of the recording on the Muscle CAP Channel in the section before the first stimulus was delivered. Place the other cursor on the peak of the first muscle CAP. The value for the V2-V1 function on the Muscle CAP Channel is the amplitude of this muscle compound action potential.
5. Record the amplitude of the first muscle compound action potential in the Journal using the one of the techniques described in data analysis section of Exercise 2, and in Table 4.

6. Repeat Steps 4 and 5 on each of the other muscle compound action potentials in this sweep.

7. To display another sweep made with a different interval between stimulus pulses, click on the tab for that sweep in the Sweep Selection bar at the bottom of the Analysis window. The sweep that is selected will appear on the Analysis window.

Table AN-3-L4: Amplitudes of Multiple Muscle Compound Action Potentials with Different Stimulus Frequencies.

<table>
<thead>
<tr>
<th>Interval Between Stimulus Pulses (msec)</th>
<th>Amplitude (mV) of Muscle Compound Action Potential in Series</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1st</td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

6. To take measurements from the second sweep displayed on the Analysis window, select its name from the Sweep menu in the upper left margin of the data display window. Repeat Steps 4 and 5 to measure and record the amplitudes of the five muscle compound action potentials in the sweep.

Figure AN-3-L5: The upper left corner of the Analysis window showing the Sweep menu used to select the sweep to be measured.

9. Measure and record the amplitudes of the muscle compound action potentials in the three other sweeps in Exercise 3. Follow the directions explained earlier in this data analysis section to display, select, measure, and record data.

10. Select Save in the File menu.

Animal Nerve – Neuromuscular Studies – Labs AN-3-11
11. Click on the Main Window icon to return to that window.

**Questions—Facilitation of the Muscle Response**

1. How does decreasing the interval between successive stimulus pulses affect the amplitude of the compound muscle action potential?
2. What practical implication does this phenomena have for muscle function?

**Exercise 4—Effects of Eserine**

1. Use the Sweep Selection bar at the bottom of the Main window to display the first sweep recorded in Exercise 4. Click on the tab on the selection bar for that sweep and the sweep will appear on the Main window. According to the design of the exercise, the nerve-muscle preparation was bathed with normal Ringer’s solution and the stimulus pulse delivered to the nerve in this sweep had an amplitude of 0.100V.
2. Transfer the sweep to the Analysis window by clicking on the Analysis window icon.
3. Maximize the height of the traces on the Nerve and Muscle CAP Channels by clicking on the arrow to the left of the title of each channel to open the channel menu. Select Scale from the menu and AutoScale from the Scale submenu.
4. Measure the amplitude of the muscle compound action potential. Place one cursor on the baseline of the recording on the Muscle CAP Channel in the section before the stimulus was delivered. Place the other cursor on the peak of the muscle CAP. The value for the V2-V1 function on the Muscle CAP Channel is the amplitude of this muscle compound action potential.
5. Record the amplitude of the muscle compound action potential in the Journal using the one of the techniques described in data analysis section of Exercise 2, and on Table 5.
6. Measure the duration of the muscle compound action potential (CAP). Place one cursor on the beginning of the muscle CAP displayed on the Muscle CAP Channel. Place the other cursor at the end of the muscle CAP. The value for the T2-T1 function on the Muscle CAP Channel is the duration of the muscle compound action potential in this sweep.
7. Record the duration of the muscle compound action potential in the Journal using the one of the techniques described in data analysis section of Exercise 2, and on the data table.
8. To display another sweep made with a different stimulus amplitude, click on the tab for that sweep in the Sweep Selection bar at the bottom of the Analysis window. The sweep that is selected will appear on the Analysis window.
9. To take measurements from the second sweep displayed on the Analysis window, select its name from the Sweep menu in the upper left margin of the data display window. Repeat Steps 4 through 7 to measure and record the amplitude and duration of the muscle compound action potential in the sweep.
10. Measure and record the amplitudes and durations of the muscle compound action potentials in the other sweeps made with different stimulus amplitudes in both treatments (Ringer’s solution and Ringer’s solution with eserine). Use the same techniques explained earlier to display, select, measure, and record the data.

11. Select Save in the File menu.

12. Click on the Main Window icon to return to that window.

Table AN-3-L5: Amplitudes and Durations of Muscle Compound Action Potentials Before and After Treatment with Eserine.

<table>
<thead>
<tr>
<th>Stimulus Amplitude (V)</th>
<th>Normal Ringer’s</th>
<th>Ringer’s with Eserine</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Muscle CAP Amp (V)</td>
<td>Muscle CAP Period (msec)</td>
</tr>
<tr>
<td>0.100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.200</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.500</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Questions—Effects of Eserine
1. Does eserine have any effect on the excitability or threshold of the muscle?
2. What is the mechanism of action of eserine?

Exercise 5—Effects of Other Agents
1. Use the same techniques used in the analysis of Exercise 4 to take measurements from the data in Exercise 5.
2. Use the same techniques used in Exercises 2, 3 and 4 to record the measurements from this exercise in the Journal, and on Table 6.
3. Select Save in the File menu.

**Questions-Effects of Other Agents**

1. Does the agent that you tested have any effect on the excitability or threshold of the muscle? Those of the nerve?

2. What is the mechanism of action of your agent?

**Table AN-3-L6: Amplitudes and Durations of Muscle Compound Action Potentials Before and After Treatment with Other Agents.**

<table>
<thead>
<tr>
<th>Stimulus Amplitude (V)</th>
<th>Normal Ringer’s</th>
<th>Ringer’s with _____</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Muscle CAP Amp (V)</td>
<td>Muscle CAP Amp (V)</td>
</tr>
<tr>
<td></td>
<td>Muscle CAP Period (msec)</td>
<td>Muscle CAP Period (msec)</td>
</tr>
<tr>
<td>0.100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.200</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.500</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>